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Introduction

Shear strength represents the resistance of a soil to failure in shear, a concept required in analysis for the stability of soil masses. If at a point on any
plane within a soil mass the shear stress becomes equal to the shear strength of the soil, then failure will occur at that point, where material behavior
changes from linearly elastic to perfectly plastic. Since shear stress in a soil can be resisted only by the skeleton of solid particles, shear strength
(where the material yields: ;) should be expressed as a function of effective normal stress at failure ('), where c'is the effective cohesion intercept

(stress-dependent component) and ' is the effective angle of shearing resistance or the internal angle of friction (stress-independent component),
respectively:

§= C'+'fan'.
Failure will therefore occur at any point in the soil where a critical combination of shear stress and effective normal stress develops.

Marine sediments exhibit similar behavior in that the stress decreases as the sediment is strained beyond a peak stress. The effective cohesion
intercept and the effective angle of shearing resistance are mathematical constants defining a linear relationship between shear strength and effective
normal stress. Shearing resistance is created by interparticle forces; therefore, if effective normal stress = 0 then shearing resistance must be 0
(unless there is cementation between the particles) and ¢’ = 0.

States of stress in two dimensions can be represented on a plot of shear stress () against effective normal stress ('). A stress state can be represented
either by a point with coordinates and ' or by a Mohr circle defined by the effective principal stresses 1' and 3' (see Figure 1). The line through the

stress points or the line tangent to the Mohr circle may be straight or slightly curved and is referred to as the failure envelope. The Mohr failure
hypothesis states that the point of tangency of the Mohr failure envelope with the Mohr circle at failure determines the inclination of the failure plane. A
state of stress represented by a stress point that plots above the failure envelope or by a part of the Mohr circle above the envelope is impossible.

There are two methods of specifying shear strength parameters:

1. The envelope is represented by the straight line defined by equation 1, from which the parameters ¢' and ' are found. These are referred to as
the tangent parameters and are only valid over a limited stress range. If the failure envelope is slightly curved the parameters are obtained
from a straight line approximation to the curve over the stress range of interest. The use of tangent parameters does not infer that the shear
strength is ¢' at zero effective normal stress.

2. A straight line is drawn between a particular stress point and the origin or a line is drawn through the origin and tangential to a particular Mohr
circle. The parameter ¢' = 0 and the slope of the line gives ', the shear strength equation being

§= fan’.

The angle ' found in this way is referred to as a secant parameter and is valid only for one particular stress state. The value of secant (') is generally
the highest expected value of effective normal stress (i.e., the lowest value of the parameter for the stress range of interest).
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Figure 1. Mohr-Coulomb Failure Criterion.

The relationship between the shear strength parameters and the effective principal stress at failure at a particular point can be deduced. The general
case w/c’ > 0 is shown in Figure 1, compressive strength taken as positive. The coordinates of the tangent point are (;,';) where

¢=[(1-"3)sin(2))2, and
=11 +'3)/2] + [(1 —'3)cos(2))2

and is the theoretical angle between the major principal plane and the plane of failure. The Mohr-Coulomb strength criterion is the combination Mohr
failure envelope, approximated by linear intervals over certain stress ranges, and the Coulomb strength parameters.

Since
=45° + ('/2), and

sin() = [(; —'g)/2)/[c'cot(’) + (‘; +'3)/2]; therefore,
(1 ="g) = ( +7g)sin() + 2c'cos(), or
'} =3 tan?[45° + (/2)] + 2ctan[45° + (12)].
This equation is known as the Mohr-Coulomb failure criterion.

When a material is sheared under a load or applied stress, excess pore water pressure is produced that may or may not escape depending on the
permeability of the material and the time available.

In the undrained shear scenario, volume changes translate into pore pressure changes and the assumption is made that the pore pressure and
therefore the effective stress (' = — u) are identical to those in the field. The total, or the undrained, shear strength is used for stress analysis. Tests
must be conducted rapidly enough so that undrained conditions prevail if draining is possible in the experimental setup.

In the drained scenario, shear stress is used in terms of effective stresses. The excess hydrostatic pressure must be measured or estimated. Knowing
the initial and the applied (total) stresses, the effective stress acting in the sediment can be calculated. This approach is philosophically more
satisfying because pore water cannot carry any shear stress (i.e., shear strength is thought to be controlled by the effective stresses). Drained shear
can ordinarily be determined only in the laboratory and the procedure is not popular because there are serious practical problems. Particularly in low-
permeability material, the rate of loading must be sufficiently slow to avoid the development of excessive pore pressure, which can cause a test to take
many days or weeks.

For a given state of stress it is apparent that, because '; = ; — v and '; = ; — u, the Mohr circles for total and effective stresses have the same diameter
but their centers are separated by the corresponding pore water pressure u. Similarly, total and effective stress points are separated by the value of u.

The shear strength parameters for a particular soil can be determined by means of laboratory tests on specimens taken from representative samples

of the in situ soil. These tests should only be used as guides because there are many reasons why the results are only approximate. Particularly, the
influence of pore pressure changes during the undrained experiment cannot be estimated.

Sediment Strength Measurement
Sediment strength can be measured using one of 3 systems:
® Giesa Automated Vane System (AVS)

® Torvane
® Pocket penetrometer
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Strength measurements onboard the ship can take 2 forms:

® Shear strength
® Compressive strength

Shear Strength

Shear measurements can be made using either the Giesa AVS or the Torvane. The AVS is controlled via Giesa's proprietary software (GeoLAB). The
Megauploadatron (MUT) program is used to upload AVS results to the LIMS database. Torvane results are entered via the Java program
PenStrength, which transfers the data automatically to LIMS. IODP x, y, and z-axis conventions are shown in Figure 2.

Compressive Strength

Compressive measurements are made with the pocket penetrometer, after which results are entered via the Java program PenStrength, which
transfers the data automatically to LIMS.

Sample preparation

There is no sample preparation required for these tests; however, the test destroys the sample so approval must be granted by the curator.

® Choose a test location with care to avoid particles that would influence the reading.
® Avoid obviously disturbed areas.

® For saturated cohesive sediments, take the reading in a fresh cut surface.

® Rapid drying will greatly influence the reading.

Lz
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Figure 2. Core x-, y-, and z-directions.

Giesa AVS

Automated Vane Shear (AVS) Test

The AVS test is used for in situ determination of the undrained strength of intact, fully saturated clays (undrained strengths < 100 kN/m?2); the test is
not suitable for other types of soil or if the clay contains sand or silt laminations.

A four-bladed vane is inserted into the split core and rotated at a constant rate to determine the torque required to cause a cylindrical surface (with a
diameter equal to the overall width of the vane) to be sheared by the vane. This destructive measurement is done in the working half, with the rotation
axis parallel to the bedding plane. The torque required to shear the sediment along the vertical and horizontal edges of the vane is a relatively direct
measure of the shear strength. Typical sampling rates are one per core section until the sediment becomes too firm for insertion of the vane.

The rate of rotation of the vane should be within the range of 6°-12°/min.

Clays may be classified on the basis of undrained shear strength as shown below. The GeoLab software that controls the AVS calculates shear stress
as follows:

Stress (kN/mZ) = torque (Nm) x Vane constant (1/m3) x 1/1000.

Undrained shear strength of clays are as follows:
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Stiffness state | yUndrained strength (kN/m?)

Hard >300
Very stiff 150-300
Stiff 75-150
Firm 40-75
Soft 20-40
Very soft <20

AVS Hardware

The Giesa AVS consists of the following hardware components:
® FL2 Frame (Figure 3)

® FL2SS Controller with Step-Down Transformer (Figure 4, Figure 5)
® Vane Blades (Figure 6)

FL2 Frame

The vane blade is manually raised and lowered using the crank handle at the top of the test rack. The vane blade attaches to a keyless chuck.

Figure 3. Giesa FL2 Frame with Blade.

FL2SS Controller with Step-Down Converter
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Figure 5. Back View of FL2SS Controller.

Figure 4. Front View of FL2SS Controller.

Vane Blades

A:12.7x12.7 mm
B:12.7 x 19.0 mm
C:12.7 x25.4 mm
D:20.0 x 30.0 mm
F: 30.0 x 60.0 mm
G: 40.0 x 80.0 mm

Figure 6. Vane Blades.
AVS Specifications

Specification Description

Torque limit (Nm) —1.5 to ~2.5 (only forward turning to ~3.4)

Torque measurement: 2 analog force sensors

Measurement range ~1000 stage partitions/sensor

Event timing (ms) 100

Total torque Sum of individual sensor standardized values

Dissolution (Nm) 0.001 + 0.3% of final value

Angle measurement: Digital stepper (IGR) in motor

Accuracy Dependent on flexural rigidity of test rack and force sensors
Dissolution ~0.04°

Rotation measurement: | 2 encoders: rotation of applied stress and rotation of vane

Rotation limit (°/s) 0-20

Software

The AVS system is controlled by a PC with Windows environment that has the following software installed to run and upload AVS measurements:

Page 6 of 21



® GeolLAB

® Giesa license file
® Microsoft Excel
® MUT uploader

Setting up the Giesa Software to Run an AVS Sample

1. Using the desktop icon, open the Giesa main control screen (Figure 7).

2. Start a new project (for a site or a hole): select Project > New > Project. Standardize file nomenclature, i.e., Exp_SiteHole (e.g.,
301_U1301A).

3. Start a new test in the project folder: select Project > New > Test. Standardize naming: CoreTypeSection_Offset (e.g., 1H1_15) or
TexdID_Offset.

4. From within GeoLAB, select the Excel icon to open the template for acquiring data (e.g., Template_Expedition_317.xls; see Figure 8, Figure
9); enable macros if asked. Do not rename or move the template file, which will be used the entire expedition.

5. In the template file specify or enter the following:

Vane blade ID (vane type)

Rotation rate (green "speed level" cell)
Expedition, Site, Hole, etc.

Start with a rotation time of 15°/s.

3% GeolAB *** Version: 3,220 *** Gesellechaft fidr industrielle Blekironik und Sonderantriebe mbH

project  Bearbeien  System  Hife

| olx » x ST

= .ch-au:tsm FL2
i rt1_01112005 11.01.05]

it | Sistuz]

pratacel

— | ComM1

3% GeoLAB " Version: 3,230 *** Gesellschaft fiir industrielle Blektronik und Sonderantriebe mbH

| pecject Bearberen System  HiFe

B o ]
TR st
o i -
::{mmm init__| Status il
== FRTOE]
e =l
rekeane
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Figure 7. Giesa GeoLAB Main Control Screen.
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Figure 8. Selecting Giesa Main Control Template.
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Figure 9. Giesa Excel Main Control Template.

Measuring Strength Using the AVS

1. Choose an appropriate test location on the sample (see Sample preparation).

2. Measure the offset from the top of the sample section in centimeters and record in the logsheet, along with section text ID and whether the
adapter foot is being used.

3. Insert the vane manually (by turning handle on top of the Giesa) into the material until it is completely immersed (critical for accuracy and
precision) in the sediment.
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Important! If the brass spacer begins to extend on the top of the frame, the sediment is too hard for the Giesa AVS; discontinue the
measurement.
4. Select init on the Giesa GeoLAB main control screen to open a monitoring screen that shows near real-time values of torque and angle of
rotation (see Figure 10).
. Set the sampling frequency in the sample-time field; a fair estimate is 1 measurement every 2 s.
. Click on the traffic light button to begin the test.
. Go to the Excel template screen to monitor the test in progress. When the maximum shear strength of the sediment has been reached, stop
the test by clicking on the red stop-light button.
8. Record the maximum torque and angle results on the logsheet.
9. To save the results, go to the Excel template:
® Select File > Save As >
® Save to location: c:ldatalstrengthlin
®* Name: text ID_offset_AVS.csv
® Save as type: CSV (comma delimited)
10. Close Excel after saving the file.

~No o

5% GeoLAB *** Version: 3220 *** Gesellschalk fir industriell= Elektronik und Sonderantrisbe mbH

peoject  Bewbeiten  System  Hife

| ol » ¥ S@

B test_geoiect [TF]
T testd_T1112008 11 .01 08 = | COMA
£* Labor fugeizonds FL2 an COM1 [int ] stalus
arcineal

|
sah'mle1lme1 Is6 3: SEL. Dieice-Na: a5
inpat oufput My
Spaed: [ osooo [ zooo000 ek
barqua b,ooon 2,5860  Mm

et Q.UDUUI 10,0000 right
Angle of rofafion 0,000 ipoo *

[¥ EXCEL - Connaction g

Figure 10. Giesa Test Parameters and GeoLab "init" Window.

Uploading AVS Results to LIMS
Strength results are uploaded to the LIMS database via MUT uploader. Double-click on the MUT icon.

1. Log into MUT (Figure 11) to open the main application window (Figure 12).
2. Click Upload and wait for file disappear from the upload list.

All data is moved from the C:/Data/In to C:Data/Archive folder when uploaded correctly. If there is an error with the file it will be moved to the C:/Data

/Error folder.

m MegaUploadaTron (MUT) [V x|
Connect to:

- { SHP )

Username:

Password:

v

version 14.0.0.0 - SHIP
Figure 11. Logging into MUT Uploader.
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Figure 12. MUT upload screen. Green check means file is in correct format for uploading to LIMS.

Giesa Vendor Contact

Giesa mbH, Heinrich-Heine-Stral3e 16

01723 Wilsdruff

T : +49 (0) 35204 40602, F : +49 (0) 35204 40604
mail@giesa.de, www.giesa.de

Torvane

The Torvane shear device (ELE International model 26-2261; Figure 13) enables the user to quickly determine the shear strength of cohesive soils.
All that is required is a relatively flat sample area at least 2 inches (50 mm) in diameter. The device has a stress range of 0-2.5 kg/cm? (tons/ft2), the
approximate range of torque that can be easily applied by the fingers. The dial head is equipped with a mechanism to hold the maximum reading after
release. The smallest division on the dial is 0.1 kg/cm?2, permitting visual interpolation to the nearest 0.05 kg/cm?.

The Torvane is most accurate in fully saturated cohesive soils whose undrained strength is independent of normal pressure. The stress range permits
it to be used for very soft to stiff clays. Extensive laboratory testing indicates excellent agreement in homogeneous clays between the unconfined
compression test and the Torvane. The shear strength of a cohesive soil is dependent upon many factors, including rate of loading, progressive
failure, orientation of the failure plane, and pore water migration during testing. The Torvane does not eliminate the effects of any of the variables.

i i Torvane lnstructions

DURHAM GEC @ SLOPE INDICATOR

Figure 13. Torvane Shear Device.

Three sizes of vanes are used with the Torvane:
1. The regular (standard) vane (1.0 ratio) has a stress range of 0-1 kg/cm?. This is the approximate range of torque that can easily be applied
by finger pressure. It is used for fully saturated cohesive soils.

2. Alarge vane (sensitive) is provided for use with remolded samples and has a ratio of 0.2.
3. A small vane (high capacity) for use with stiffer clays has a ratio of 2.5.

Strength limits of the Torvane adapters are as follows:
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Vane Diameter Vane Vane Maximum shear strength

(mm) Height (kPa)
Identifier (mm)
19 25 3 250
25 1.0 5 100
48 0.2 5 20

Torvane Hardware

—Part number EI26-2261: includes driver, 3 interchangeable vanes, and carrying case

—Scale: 1 kgicm? x 0.1 kg/cm? divisions
—Vane driver: 1.6 inch (41 mm) diam. x 3.2 inch (81 mm) with vane attached

—Vanes:

® EI26-2261/10: large, sensitive vane (0.2)
® EI26-2261/12: regular, standard vane (1.0)
® EI26-2261/14: small, high-capacity vane (2.5)

—Carrying plastic case

Dimensions: 6 x 4 x 2 inches (152 x 102 x 51 mm)
Net weight : 10.5 oz. (300 g)

Measurement Specifications

—Sample types:

Fully saturated cohesive soils

® Very soft to stiff homogeneous clays

—Sample area: flat area at least 2 inches (50 mm) in diameter
—Stress range: 0-2.5 kg/cm? (tons/ft?)
—Sensitivity: visual interpolation to nearest 0.05 kg/cm2

Measuring Strength Using the Torvane

1.
2.

3.

IN

©oo~NO U,

Choose an appropriate test location on the sample.
Measure the offset from the top of the section (cm) and record in the logsheet, along with the section text ID and which vane adapter foot is
used.
Select the desired vane size and attach to the driver and attach to the stem by pressing the end of the stem all the way into the square
recess on the vane.

® 1inch regular vane (25.4 mm diameter, 1.0 multiplier): 0-1.0 kg/cm2

® 1-7/8 inch large vane (47.6 mm diameter, 0.2 multiplier): 0-0.2 kg/cm?

® ¥ inch small vane (19 mm diameter, 2.5 multiplier): 0-1.5 kg/cm2

. Make sure that the dial is aligned with the zero mark. Turn the dial face counterclockwise (while holding onto the handle) until the zero mark

aligns with the index mark on the handle.

. Hold the Torvane at a right angle to the surface and press into the soil to a depth of the blades.

. Maintaining a constant vertical pressure, turn the handle at a constant rate such that failure occurs in 5-10 s.

. After failure occurs, slowly release the remaining spring tension.

. Take a reading on the dial where the handle's index mark rested—this is the maximum shear value—and record the result on the logsheet.
. Before taking the next measurement, re-zero the scale by rotating counterclockwise until it aligns with the index.

Entering Results and Uploading Data to LIMS

All strength results are uploaded to the LIMS database via a Java program. To run the program, double-click on the icon PenStrength.

abswWNE

. Log into the application with your LIMS username/password (Figure 14) to open the main application window (Figure 15).

. Select the Torvane radio button.

. Select Label ID info. (Figure 16). Select the sample from the Sample Table underneath the hierarchy search.

. Enter pertinent info (Offset, Adapter ID, Alignment, and Raw Instrument Reading).

. Press Save. Clicking Save uploads the measurement into LIMS and shows the correction applied for the selected adapter foot.
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—
[EW PenetrationStrength.bat - Shortcut = |E

C:~IODP~PenStrength>"C:~Program Files“Java~jrel.B.@_%21vbinjava.exe" —jar G:
P~ PenStrengthsdist FPenetrationStrength.jar C:»I0DP PenStrength-propertiesspen
ationstrength.property

Penetration Strength started...

INFO 31-July-2816 B5:31:56:568

Penetration Strength

Integrated Ocean Drilling Program

linited States Implementing Organization

Texas A&M University

18388 Discovery Drive College Station. Texas 77825
Author: Duwight Hornbacher

The application has successfully been loaded.

User's Oracle Account Name

Users Oracle Account Password

Accept
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Figure 14. Logging into the Application/LIMS Database.
|4 Penetration Strength B =
File Help
Expedition Site Hole Core Section Half-Saction Sample-Type Test Selection
Expedilion  Sample-Ty. TestList
60 - - -
Penetrate@  382T 0[5 mo |8
— asoc CAKE CARB
TEST CFRC CNTHAS
TRAIN CLTR g
Sample Table
Tile 1 Tie 2 e 3 Title 4
Offsat (cm) Adapter Foot  Working Axs Alignment Archive Ads Alignment  Compression Strength
Yes X-POS (Into) @ X-NEG (Into)
Raw Instrument Readng No Y-POS (To Right) Y-NEG (To Right)
2P0S Down) ZNEG (Up) sae |
PENETRATE Comments
Reset User Exit

Figure 15. Control Screen for Entering Results and Uploading to LIMS.

File Help
Expediion Sile Hole Cofe Section Hal-Section Sample-Type Test Selection
Expedition Site Hole Core Section Hal-Sec.. Sample-Ty... TestList
%0 4 TEST » A 4 H L 1 4 A - - -
Pentrate &) 3621 wan (] CHEEN 2 v |
Torvane @ QAQC u1473 |E 3H E 3 =
32t o I
TRAIN Us001 5% 5
i Linnan T 2 1] i ~ = b i b=
Sample Table
Label ID Text D
TEST_U362TB_4X_1_W_0- |SHLF7248111 -
Dffset (em) Adapter ID  Working Axis Alignment Archive Ads Allignment  Compression Strength
5 @ X-POS (Into) @ X-NEG (Into)
1.0
Raw Instrument Reading ¥-POS (To Right) Y-MEG (To Right)
3 Z-POS (Down) Z-NEG (Up}
TORVANE Comments
ResetUser e |

Figure 16. Entering Torvane Results.

Pocket Penetrometer

Failure can be defined as the maximum principal stress difference, which is the same as the unconfined compressive strength of the material ; — 5. At

a prescribed strain, shear strength ; is related to compressive strength ; by
fmax (1_ 3)/2 = sz'
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If the compressive strength is read directly off the pocket penetrometer, the value must be divided by 2 to get the calculated shear strength.
The penetrometer is a flat-footed, spring-operated device used to measure compressive strength by pushing a 0.25 inch (6.4 mm) diameter probe
0.25 inch (6.4 mm) deep (to the red marker) below the split-core surface (select test spots with a smooth surface) (Figure 17). The mechanical scale
is in units of kilograms per square centimeter, and the data are uploaded to the LIMS database in this form. The force in kg/cm? can be converted to
kPa by the following formula:

2; (kPa) = 98.1 x 2; (kg/cm?).

The maximum shear strength that can be measured with the pocket penetrometer is 4.5 kglcm?,
A 1 inch adaptor foot is available for measuring in very soft sediments. This provides a 16 times increase in piston area. An allen wrench is used to
loosen and tighten the set screw that holds the foot to the piston. When the foot is used, multiply the scale readings by 1/16 (0.0625).

Figure 17. Pocket Penetrometer.

Penetrometer Hardware

—Part number: EI29-3729

—Scale divisions: 0.25 kg/cm?

—Load piston: ¥ inch (6 mm) diameter stainless steel

—Dimensions: ¥ inch diameter x 6-3/8 inch long (19 mm x 162 mm)
—Weight: 7 oz (198 g)

-1 inch adapter foot: P/N EI29-3729/10

Measurement Specifications
—Sample types:

® Split core sediments
® Very soft with adapter foot

—Sample area: smooth surface

—Range: 0.25-4.5 kg/cm? (tons/ft?)
—Maximum shear strength: 220 kPa

Vendor Contact

Soiltest/ELE International
PO Box 389

Loveland, CO 80539

T :800.323.1242
F:970.663.9781
soiltest@eleusa.com
www.eleusa.com
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Measuring Compressive Strength Using the Pocket Penetrometer

The red ring on the barrel holds the maximum reading of the scale. The Java program calculates the correct measurement depending on whether the
adapter foot is used.

1.
2.

3.
. Grip the handle firmly, holding the penetrometer at a right angle to the soil surface, and insert the shaft into the soil with a smooth constant

Choose an appropriate test location on the sample.

Measure the offset from the top of the sample section (cm) and record in the logsheet, along with section text ID and whether the adapter foot
is being used.

Return the red ring to position against the penetrometer body, making sure that the front edge is at the zero reading.

force to the groove ¥4 inch from the tip. If the adapter foot is used on very soft soil, push the foot into the soil the total thickness of the foot.

. Read the unconfined compressive strength (kg/cm?) from the scale. The reading is located on the lower side of the red ring; the side closest

to the handle.

. Record the result on the logsheet.

Entering Results and Uploading Data to LIMS

All strength results are uploaded to the LIMS database via a Java program. To run the program, double-click on the icon penetration.

arwWNE

. Log into the application with your LIMS username/password (Figure 18) to open the main application window (Figure 19).
. Select the Penetrometer radio button.

. Select Label ID info. (Figure 20). Select the sample from the Sample Table underneath the hierarchy search.

. Enter pertinent info (Offset, Adapter ID, Alignment, and Raw Instrument Reading).

. Press Save. This uploads the measurement into LIMS.
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BN PenetrationStrength.bat - Shortcut Llﬂli]

C=~I10DP“FPenStrength>"C:“\Program Filesz“Javasjrel.8 . 8_%1hinsjava.exe" —jar G:%
P~FenStrength~diszt“PenetrationStrength.jar C:~I0DP~PenStrength-properties pen
ationstrength.property

Penetration Strength started. ..

INFO 31-July-208i6 B5:31:56:568

Penetration Strength

Integrated Ocean Drilling Program

United States Implementing Organization

Texas A&M University

1888 Dizcovery Drive GCollege Station, Texas 77825
Author: Dwight Hornbhacher

The application hasz successzfully been loaded.

User's Oracle Account Name

Users Cracle Account Password

Accept Cancel

— E i TaF e B 1 7
Figure 18. Logging in to the Application/LIMS Database.
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Expedilion Site Hole Core Section Hall-Section Sample-Type Test Selection

| & Penetration Strength
File Help

Expediion  Sample-Ty TestList
|0 - -
Penetrate @ 36827 BEAD g BIO Ci
S— osac CAKE CARE
: TEST CFRC CNTMAS
TRAIN CLTR ruet
e -1 i Al L
Sample Table
Title 1 Title 2 Title 3 Title 4
Offsat (cm) Adapter Foot  Working Axs Archive Axis (v Strangth
O es ) X-POS (Into) ® X-NEG (Into)
Raw Instrument Reading to | Y-POS (To Right) 1 Y-NEG (To Right)
) 2-POS (Down) %) Z-NEG (Up) save_|
PENETRATE R
ResetUser | [ Eit |

Figure 19. Control Screen for Entering Results and Uploading to LIMS.

| 4| Penetration Strength
File Help
Expedition Site Hole Core Sedlion Hall-Section Sample-Type Test Selection
Expedition  Site Hoale Core Section HalfSec.. SampleTy.  TestList
30 - TEST + A - w o+ [ - A - - -
Penetrate ® 3827 Tran (] CHENN 2
S oAac U1473 |2 Ho= 3 =
o | -
TRAIN Us001 E 5
= vnnnan T ad 1= s ~r hd b= be s
Sample Table
Label ID TextID
TEST_U362TE_dX_ SHLF7248111 i
Offsat (cm) Adapter Foot  ‘Working Axs Allg Archive Ads Alig Compr Strength
25 D) Yes ® X-POS (Into) ® X-NEG (Into) 40
Raw Instrument Reading @ Mo ¥-POS (To Right) ¥-NEG (To Right)
4.0 ") Z-POS (Down) ) Z-NEG (Up) fiae
PENETRATE B
ReselUser | [ Bt |

Figure 20. Entering Penetrometer Results.

LIMS Integration

Sample and Analysis Attributes and Components

Analysis Component Unit

VANE_SHEAR | offset cm

Explanation

Offset from top of section; location of measurement in section
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penetration_direction X-, Y-, Or z-axis measurement

-into X

-intoY

-into Z

-into -Z

rotation_rate deg/s  Geisa vane rotation rate
shear_strength Pascal

residual_strength Pascal

max_torque_angle °circ

residual_torque_angle @ °circ
comment From AVS data entry form
PENETRATE  offset cm Offset from top of section; location of measurement in section
penetration_direction X-, y-, Of z-axis measurement
-into X
-intoY
-into Z
-into -Z
adapter_foot Was adapter foot used for very soft sediment?
- yes (1/16)
-no (1)

compression_strength kg/cm2 Converted result

comment From PenStrength data entry form
TOR_SHEAR | offset cm Offset from top of section; location of measurement in section
penetration_direction X-, y-, OF Z-axis measurement
-into X
-into Y
-into Z
-into -Z
adapter_id Which blade was used on the device?

- regular (1.0)

- large (0.2)

- small (2.5)

shear_strength kglcm? | Converted result

comment From PenStrength data entry form

Viewing Logfile
At any time you may peruse the lodfile. Click on the view logfile button from the AVS main control (Excel)
program.

All actions and results are entered in this file. For example, if there is a problem connecting to the LIMS database, you can just go to this log to look at
your results.

Reviewing Results from LIMS
To view results, open LIMS web data search:

. Open browser and go to http://ship.iodp.tamu.edu/LORE/

. Under Select Report, click Physical Properties > Strength, Automated Vane, Torvane, or Penetrometer, as applicable.
. Under Select Sample Range, enter Expedition, Site, Hole, etc., as needed to narrow the data search.

. Click View data or Download data file to view or download the data.

A WOWN P
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Health, Safety, & Environment

—Do not force the blade into sediment that is too hard.
—Do not expose any part of the unit to force >40 N; twisting moment may exceed 4 Nm.

Maintenance & Troubleshooting

Maintenance

Daily

Thoroughly clean AVS frame, removing dust and material, taking special care with threaded rods and bores.

Annually

Torque sensor adjustment and certification is recommended by the manufacturer.

Troubleshooting

AVS Status Displays

Status message Meaning
ready for use FL2 is not busy; press START to begin a test
attempt runs Manually initiated test; terminate using the STOP button

equipment disturbed = Error detected; see below

ST attempt runs PC-initated test; START and STOP buttons are deactivated

AVS Error Displays

When the AVS controller detects an error, the NET light on the front of the controller flashes and an error message displays.

Error message Explanation

Storage error Internal memory error

Maximum strength = At least 1 internal force sensor has reached maximum value; further testing may
damage force sensor

Overflow condition | Vane rotated > 8000°

Force sensor is —A force sensor is not connected
missing —Force sensors have been switched

Giesa Installation Information

AVS Hardware

FL2 Frame

® S/N 745-1, Made in Germany
® Analog force sensors (load cells):
* Type: KAB K1. 0,1 Bj.2004, Made in Germany
mV/V =50 N FNr 04-2929
P67
A.S.T. GmbH Dresden
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Action

Requires electronics repair

Terminate test and restart with a
smaller vane

Add 8000°¢ to final result for this test

Check cable connections at back of
FLSS



Mars chnerstrasse 26 D-01287 Dresden

Excitation (+)/SP+ brown

Sense (+)/F+ gray

Screen/SCH black

Signal (+)/S+ red

Sense (-)/F- blue

Excitation (-)/SP- green

Signal (-)/F— white

® Stepper motor with all cable connections
® Portescap Turbo Disc™ PP 520 00466, ED 0304
® Made in Switzerland

® Vane clamping device (uses keyless clamping chuck)

FL2SS Controller

® S/N 745

® Made in Germany

® Control box inputs
® Left torque : analog force sensor (Nm)
® Right torque : analog force sensor (Nm)
® Motor : driving motor
® IGR : rotational sensor

Step-down Converter

* SIMRAN SYM-200DE
® Made in China

Computer Hardware

The Giesa equipment is controlled by a PC running Windows Operating System. The FL2 uses a RS232 interface for automatic control of the entire
test process. Remove any other hardware from the serial ports; the data send for port probing might be misinterpreted and cause errors in
unsupported devices. RS232 settings are:

® COM port
® 9600 baud : 8 data bits : no parity : 1 stop bits : no flow control

Power Requirements

® Power requirements: 230V AC, 50/60 Hz, 0.3 A
® Attach this unit to mains socket with a grounded earth.
® To avoid any potential electrical disturbances, connect the PC and the FL2SS to the same circuit.

Maintenance

® [tis recommended that the force sensors be adjusted/tuned annually by Giesa mbH.

® Change the fuse on the FL2SS only with the power supply cord unplugged from mains.
® Make sure the unit is powered off before exchanging cables.

® Do not expose the unit to forces over 40 N; the twisting movement may exceed 4 Nm.

Software
AVS is controlled by a PC with Windows environment that must have the following software installed to run and upload AVS measurements:

GeolLab

Giesa license file
Microsoft Excel
LabVIEW uploader
Java

Geolab

Install the GeoLab software by running the setup.exe file found on the software volume or a backup media CD. For full software functionality, a
license must be obtained from Giesa mbH. Without a license, the software is limited to 50 values per measurement.

Geisa License

Install the new GERAETE.DBF file in the installation directory. This file contains the new hardware in an encrypted style. Do not try to edit this file. Any
changes might damage or even destroy the file and render the program unusable.

Excel
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Microsoft Excel will also need to be installed. The Giesa software uses Excel as an interface. Values are written to, and parameters read from,
predefined spreadsheet cells providing full flexibility of Excel functions to the measurements. The Excel parameters take precedence over the Giesa
parameters.

RS-232 COM

At startup, the program searches all available serial ports for hardware. All hardware needs to be online at this point. Detected hardware and ports are
displayed graphically. A flashing red dot signals a hardware error. Double-click the dot for more details.

Credits

This document originated from Word document Strength_UG_372.docx (see Archived Versions below for a pdf copy) written by E. Moortgat (2008-04-
16) and edited by M. Hastedt, D. Houpt, H. Barnes, S. Herrmann; T. Cobb. Credits for subsequent changes to this document are given in the page
history.

Archived Versions

® Strength_UG_372.docx: Word file of the Sediment Strength User Guide that was edited on Expedition 372 and is superseded by this
wiki page.
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